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These release notes for Cisco Conference Connection 1.1(3) contain import
information for new installations and upgrades. The release notes also desc
resolved and known problems in Cisco Conference Connection 1.1(3).

The release notes provide the following information:

• Documentation Roadmap, page 2

• Caveats, page 2

• Document Erratum, page 15
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• Obtaining Technical Assistance, page 43
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Documentation Roadmap
Use these publications to learn how to install and use
Cisco Conference Connection:

Caveats
Caveats are unexpected behaviors or defects in Cisco hardware releases. Th
graded according to severity level. These release notes contain information 
severity levels 1, 2, 3 (and some 4’s) only. You can search for known problems
the Cisco bug tracking system tool, called Bug Navigator II.

To access Bug Navigator II, perform one of the following actions:

• Enter the following URL in your web browser:
http://www.cisco.com/support/bugtools

• Log in to CCO and select Service & Support > Technical Assistance
Center > Tools > Software Bug Toolkit Bug Navigator II

Table 1 lists problems resolved in Cisco Conference Connection Release 1.1

Table 2 lists existing problems in Cisco Conference Connection Release  1.1

Document Name Description and Location

Cisco Conference Connection
Administration Guide

Provides information for network and telephone administrators abou
installing, configuring, and troubleshooting
Cisco Conference Connection.

URL:http://www.cisco.com/univercd/cc/td/doc/product/voice/
cccdocs/index.htm

Cisco Conference Connection
Quick Start Guide

Describes how to use Cisco Conference Connection.

URL:http://www.cisco.com/univercd/cc/td/doc/product/voice/
cccdocs/index.htm
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Table 1 Cisco Conference Connection 1.1(3) Resolved Problems

DDTS Number Description

CSCdw62893 The DC Directory does not start after the upgrade to Cisco CallManager 3.2 wit
the Cisco Conference Connection User Synchronization process running on the
Cisco CallManager server.

CSCdw20603 The login to Cisco Conference Connection fails after synchronization with
Cisco CallManager 3.2.

CSCdt66668 A participant cannot rejoin a conference after hold or implied hold.

CSCdu43907 A participant doesnot get a response when an ID is not valid.

CSCdu44471 A participant cannot transfer a caller into conference.

CSCdu88956 On screen instructions are not clear for entering a license.

CSCdv44493 An error occurs when a participant adds a space before the conference name.

CSCdv47224 The option for a new key is not removed when the maximum license is reache

CSCdv66287 The User Synchronization Process Installation to the LDAP directory on
Cisco CallManager is not automatic.

CSCdv21880 The first-party announcement is not available in conference.

CSCdw21904 There are no Japanese voice prompts to provide the Telephone User Interface

CSCdw21914 The Operator Extension should be optional on the Cisco CallManager AppAdmi
pages.

CSCdw35816 A participant is unable to access Cisco Conference Connection web pages
because of special characters in the MSDE password.

CSCdw35849 Cisco Conference Connection does not allow a period in the user name but
Cisco CallManager does.

CSCdv11355 The entry tone is too loud.
CSCdv04464 TheCisco Conference Connection Administration Guideshould not be visible on the

Regular/Guest Info screen.
CSCdu51093 Callers get a busy signal or are dropped when calling the primary

Cisco Conference Connection number when Cisco CallManager fails over.

CSCdw89562 The Cisco Conference Connection Metalink agreement is corrupted during
Cisco CallManager upgrade to version 3.2.
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Caveats
Table 2 Known Problems in Cisco Conference Connection 1.1(3)

DDTS Number Description Solution/Work Around

CSCdw68175 When a user subscribes to the
Cisco Conference Connection IP Phone
Service, the user may be asked to enter
his password.

The user should be automatically logged
into the list of conferences.

This problem can be resolved as follows:

1. In the Cisco CallManager
administration pages where Cisco IP
Phone service is configured, in the
Service Parameter Information page,
be sure to enter the names of the
parameters exactly as shown here,
with the first character capitalized:

Name
Password

2. Users must enter their passwords to
log into the
Cisco Conference Connection
service.

CSCdw64700 When the Cisco CallManager service is
manually shut down, Cisco CallManager
failover occurs and in-conference audio
channels are cut off.

If the failover occurs for other reasons
(for example, the power goes off or a
network cable is unplugged), the
in-conference audio channel(s) remain
active.

This problem rarely occurs. To avoid it
completely, do not manually shut down
the Cisco CallManager service.
Manually shutting down
Cisco CallManager causes the running
conferences to be disconnected.
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Caveats
CSCdu74973 Using a MIB Browser tool, you can see
the version of Cisco Conference
Connection (in the Serviceability Table
sysAppMIB/sysAppInstallPkgEntry/
sysAppInstallPkgVersion2).

The Cisco Conference Connection
version incorrectly shows 1.1(2) instead
of 1.1(3).

To check which version of
Cisco Conference Connection you are
running:

On the Admin pages of
Cisco Conference Connection, click the
About button in the menu on the top of
the screen.

The Cisco Conference Connection
version displays.

CSCdu75518 Cisco Conference Connection does not
distinguish between a blank
administrator password and a password
containing spaces only.

Do not use spaces in a password. Choose
a password containing digits and letters.

CSCdw67381 After a Cisco Conference Connection
server is upgraded to operating system
version 2000-1-3, the
Cisco Conference Connection
administration pages become
inaccessible and the virtual directory
“Scripts” is removed.

Recreate the virtual directory as
described in the solution to
CSCdv18352.

Table 2 Known Problems in Cisco Conference Connection 1.1(3) (continued)

DDTS Number Description Solution/Work Around
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Caveats
CSCdv18352 During the installation of
Cisco Conference Connection, the
Scripts virtual directory may fail to be
installed, and therefore the
Cisco Conference Connection web
components installation is incomplete.

After the installation, perform the
following steps:

1. From the Windows 2000 desktop,
selectStart > Programs
> Administrative Tools
> Internet Services Manager.

2. In the left pane, select the
Cisco Conference Connection
server.

3. In the right pane, double-click
Default Web Site.

A list of all of the virtual directories
appears in the right pane.

4. Check to see if the Scripts virtual
directory appears in the list.

5. If the Scripts virtual directory does
not appear in the list, in the right
pane right-clickDefault Web Site
and select
New > Virtual Directory .

The Virtual Directory Wizard starts.

6. Click Next to continue.

7. In the Alias field, enter Scripts, and
the clickNext.

8. Click Browse, and browse to the
C:\Inetpub\Scripts folder.

9. Click OK , and then clickNext to
continue.

10. Clear the Read and Run scripts (such
as ASP) checkbooks, and then click
Next.

11. Click Finish.

Table 2 Known Problems in Cisco Conference Connection 1.1(3) (continued)

DDTS Number Description Solution/Work Around
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Caveats

s.
12. In the left pane, right-clickScripts
and clickProperties.

13. In the Execute Permissions field,
select Scripts and Executables from
the drop-down list.

14. Click OK , and then restart the
Cisco Conference Connection
server.

CSCdt69224 When viewing the participant
information for a past conference, the
participant column may contain an IP
address, not the phone number of the
participant. This usually occurs when the
Caller ID is unavailable. The IP address
is the address of the Gateway (or
sometimes the Cisco CallManager) that
directed to the call to
Cisco Conference Connection

You can accept that no Caller ID appears
and that the gateway IP address appear

Or, you can make sure that the Caller ID
is reported by the gateway in the gateway
configuration. Ask callers to reveal their
Caller ID.

Table 2 Known Problems in Cisco Conference Connection 1.1(3) (continued)

DDTS Number Description Solution/Work Around
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Caveats
CSCdt86769 If a time period during which scheduled
conferences consume all or nearly all of
the available conference ports, and a user
tries to create a conference, the error
“Conference Scheduling Failed” with the
reason “no resource available” may
appear.

Conference resources are reserved in
five-minute intervals:

• Conference start times are rounded
down to the nearest five-minute
interval.

• Conference end times are rounded
up to the nearest five-minute
interval.

For example, a conference scheduled for
100 ports from 10:23 a.m. to 10:43 a.m.
reserves 100 ports from 10:20 a.m. to
10:45 a.m.

Note The conference still runs only in
the scheduled 10:23 a.m. to
10:43 a.m. time interval.

Schedule conferences so that they begin
or end at five-minute intervals (for
example, 5:00, 5:05, 5:10, and so on).

Table 2 Known Problems in Cisco Conference Connection 1.1(3) (continued)

DDTS Number Description Solution/Work Around
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Caveats
CSCdt87084 If the start date of the first occurrence of
a repeating conference is after the end
date, at least one meeting will be
scheduled for that series, provided no
other conflicts occur.

For example: On August 20, 2001
(Monday) a recurring conference is
scheduled to run every Wednesday, but
the start and end date for the recurring
conference is today (Aug 20, 2001). As a
result, one conference will be scheduled
for the series. This conference will run
on Aug 22, 2001 (Wednesday), even
though this is after the end date (Aug 20,
2001).

When scheduling repeating conferences,
make sure there is at least one valid
conference that can run within the given
start and end dates.

Table 2 Known Problems in Cisco Conference Connection 1.1(3) (continued)

DDTS Number Description Solution/Work Around
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Caveats
CSCdu01568 One or more participants in one or more
conferences may be dropped from a
conference without warning and without
having taken any action.

There may be one or more causes for this
problem:

• The conference time elapsed and
resources are needed for other
conferences. In this case,
Cisco Conference Connection
terminates the running conference.

• The administrator has modified or
reset the conference server. If an
administrator modifies the route
pattern or any attributes of the
conference gateway in the
Cisco CallManager configuration, a
reset is normally performed and
calls to the conference engine are
dropped.

• A remotely connected user is
dropped because a gateway is reset.

• An administrator or the conference
creator manually stopped the
conference.

Here are some recommendations for
avoiding this problem:

• Allow sufficient time for your
conference.

• Restrict administrative changes to
off hours.

• Only reset gateways or the
conference engine when absolutely
needed.

Note If the participant is unable to
immediately reconnect, the
problem may be due to a
conference server failure or
because the conference was
stopped for administrative
changes.

Table 2 Known Problems in Cisco Conference Connection 1.1(3) (continued)

DDTS Number Description Solution/Work Around
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Caveats
CSCdu06957 Echo is heard while using
Cisco Conference Connection.

This problem is generally caused by
improper gateway configuration and thus
is most prominent when external callers
are involved in the conference. The most
important parameter to adjust is the
echo-cancel command, which is found
on IOS gateways.

Other sources of echo include:

• placing a handset face down on a
hard surface, particularly when the
volume is set to high

• feedback from some headsets and
handsets

• poor quality speakerphones

• Impedance mismatch between
phones and their network connection
(analog phones) or between a trunk
and the CO connection (analog
trunks).

One way to help eliminate various
participants as the source(s) of echo is to
ask them to mute their phones one by one
(if possible). Or, if it is not possible to
mute, then ask them to momentarily drop
out of the conference.

Note The participant who isnot
hearing echo is usually the
source of the problem.

CSCdu20908 When several participants join the
conference at the same time, or very
close together, the entry tone may not be
heard completely for each participant
who joined the conference.

Have the conference participants
announce themselves when joining a
conference.

Table 2 Known Problems in Cisco Conference Connection 1.1(3) (continued)

DDTS Number Description Solution/Work Around
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Caveats
CSCdu73866 Microsoft Database Engine (MSDE)
sometimes fails to install during the
Cisco Conference Connection
installation.

The MSDE installation running in single
user mode causes this failure. During the
installation, if some other process gets a
connection to the MSDE server, the
installation fails because it cannot get a
connection to the MSDE server (a user is
already connected). These other process
can be any of the following:

• Metalink agreements running on
Call Manager machine

• SQL Enterprise manager connecting
to the MSDE

• Monitoring services on the machine
or the network.

When you install
Cisco Conference Connection, be sure:

• To disconnect the network cable on
the machine where you are installing
Cisco Conference Connection.

• No metalink agreements are
running. If there is a metalink
agreement running on the
Cisco CallManager machine, stop it.

• No enterprise manager is trying to
connect to MSDE on this machine.

Table 2 Known Problems in Cisco Conference Connection 1.1(3) (continued)

DDTS Number Description Solution/Work Around
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Caveats
CSCdv10356 During a conference, participants
experience jittery voices, which may
sound like the speaker is underwater,
robotic, or clipped entirely.

This problem is most often observed
when participants join a conference
through gateways and in a highly
routed/switched network (multiple
hops).

The problem can be resolved as follows:

1. Attach the
Cisco Conference Connection
directly to a switch.

2. Configure the switch to lock in
100 Mbps at Full Duplex.

3. Configure the PC NIC card to the
same (100 Mbps/FDX).

a. From the Windows 2000
desktop, select
Start > Settings > Control
Panel > Network and Dial-up
Connections

b. Select and right-clickLocal
Area Connectionand click
Properties.

c. In the Local Area Connection
Properties dialog box, click
Configure to set the Ethernet
card properties.

d. In the next dialog box, click the
Advanced tab and selectLink
Speed & Duplex.

e. In the value field, select
100Mbps/Full Duplex.

4. Click OK .

CSCdv20597 Cisco Conference Connection web
pages are not accessible or the access is
too slow.

This may occur if the server for
Cisco Conference Connection is
infected with the Code Red virus.

Install the Microsoft patch to prevent the
Code Red virus. Download this patch
from:

• the Microsoft web site, or

• the Cisco Conference Connection
installation CD-ROM.

Table 2 Known Problems in Cisco Conference Connection 1.1(3) (continued)

DDTS Number Description Solution/Work Around
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Caveats
CSCdv25490 Occasionally, after a new installation of
Cisco Conference Connection,
subsystems fail to start even though the
Application Engine is shown as running
http://<machine-name>/
appadmin/Engine.

For Cisco Conference Connection to
function properly, it is necessary for the
subsystems to be running.

Reboot the server for
Cisco Conference Connection to cause
the subsystem to start.

CSCdv39677 When the Cisco Conference Connection
server rejects the call, a busy tone is
played back to the user. This tone
playback may not work when the caller
has dialed in using a H.323 gateway. This
may occur when the conference is full.

There is no workaround for H.323
gateway callers. However, if you
schedule enough ports so the conference
is not full, you will not encounter this
problem.

CSCdw28983 When using the VG200 with
Cisco Conference Connection, a
participant using a G.711 phone can join
the conference. However, when using a
G.729 phone, the participant reaches the
IVR but gets fast busy when attempting
to connect to the conference.

Dial in through a non-VG200 gateway, if
one is available.

It is recommended that you use the
Catalyst 6000 Family Voice T1/E1 and
Services Modules (product number
WS-X6608) as the transcoding resource
for Cisco Conference Connection.

If using Cisco Conference Connection
with a VG200 gateway, do not use a
G.729 phone.

CSCdt77086 If the repeat options are used when
creating a conference, using the
drop-down list boxes, it is possible to
select invalid days, like February 30. An
error appears when trying to schedule a
repeating conference that has an invalid
start or end day.

Do not select invalid dates and/or correct
them after receiving such an error.

Table 2 Known Problems in Cisco Conference Connection 1.1(3) (continued)

DDTS Number Description Solution/Work Around
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Document Erratum
Document Erratum
Table 3 corrects an error in theCisco Conference Connection Administration
Guide and in theCisco Conference Connection Quick Start Guide.

Documentation Addenda
This section contains the following information:

• Conference ID Validation in Cisco Conference Connection, page 16

• Installing Cisco Conference Connection: New Installation, page 17

• Upgrading Cisco Conference Connection, page 33

• Upgrading from Cisco CallManager 3.1, page 38

• Changes to Cisco Conference Connection When Upgrading from
Cisco CallManager 3.1 to Cisco CallManager 3.2, page 39

• Installing Japanese Voice Prompts, page 41

Table 3 Documentation Erratum

DDTS Number Description Solution/Work Around

CSCdt63974 The Hidden Conference option is
incorrectly described as the
default configuration in the
Cisco Conference Connection
Administration Guide and the
Cisco Conference Connection
Quick Start Guide.

At installation, the default
configuration is not hidden and
conferences are visible to all
users. However, you may change
the default setting to hidden. To
configure the Hidden
Conference setting, use
Administration Tasks on the Edit
Information Page.

Regardless of the default,
selection of a hidden or visible
conference may be changed at
the option of the individual
scheduling the call.
15
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Conference ID Validation in Cisco Conference Connection
The Cisco Customer Response Application (Cisco CRA) database validates
Conference ID that the participant enters. To activate this validation feature, y
must properly configure the Cisco CRA database. Refer to the“Configuring the
Cisco Customer Response Application (Cisco CRA) Database Subsystem”
section on page 28 for installation and upgrade instructions.

Read the following information to understand how Conference ID validation
works with Cisco Conference Connection:

• If the conference with the entered ID is currently running, the call is
transferred into the conference.

• If conference capacity is full, the caller gets a busy tone.

• If the conference with the entered ID has ended or the ID is invalid, the c
is disconnected.
The caller is given three attempts to enter a valid ID, if validation still fail
the call gets disconnected or transferred to the operator.

• If the conference with the entered ID has not yet started, then the
corresponding message is played to the caller in each of the following ca

– Conference starts in 1 second to 2 minutes

– Conference starts in 3 minutes to 4 minutes

– Conference starts in 5 minutes to 6 minutes

– Conference starts in 7 minutes to 8 minutes

– Conference starts in 9 minutes to 10 minutes

– Conference starts in 11 minutes to 12 minutes

– Conference starts in 13 minutes to 14 minutes

– Conference starts in 15 minutes to 16 minutes

– Conference starts in more than 16 minutes today

– Conference starts later than today

After playing this message, the call is disconnected.

To configure the Operator Extension feature, see“Configuring the
Cisco Customer Response Application (Cisco CRA) Operator Extension” sec
on page 29.
16
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After each subsequent failed attempt, the caller is provided with a more deta
help message. The caller can also choose to get more help by pressing the 

On the final (third) attempt, confirmation of entered digits is not provided and
more choices are given to the caller.

When a gateway is used to enter the conference, configure it to provide erro
busy tones to the callers. The conference propagates the notifications that it
receives.

Once started, conferences cannot be expanded to allow more participants. I
conference is full and additional participants are needed, the conference mus
stopped and recreated. All existing participants must dial back in.

Installing Cisco Conference Connection: New Installation
To installCisco Conference Connection as a new installation, perform the
following procedure in this release note:

• Overview of Installing Cisco Conference Connection, page 18

This overview procedure tells you when to perform these procedures:

• Installing the Operating System, page 19

• Setting up Cisco Conference Connection Users, page 20

• Configuring the Cisco Customer Response Application (Cisco CRA)
Database Subsystem, page 28

• Configuring the Cisco Customer Response Application (Cisco CRA)
Operator Extension, page 29

• Configuring JTAPI for Cisco CallManager Failover Support, page 30

• Configuring Music on Hold for Cisco Conference Connection, page 31

• Enabling Licenses for Cisco Conference Connection, page 32
17
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Overview of Installing Cisco Conference Connection

Perform the following steps to install Cisco Conference Connection as a new
installation:

Step 1 Perform the steps in“Installing the Operating System” section on page 19.

Step 2 Perform the steps in Chapter 2 “Installing Cisco Conference Connection” in 
Cisco Conference Connection Administration Guide.

Step 3 Perform the steps in Chapter 3 “Cisco Conference Connection Configuration
theCisco Conference Connection Administration Guideexcept for the following
changes. Perform the procedures in this release note as described here:

a. When you are performing the steps in the “Adding CTI Ports in Cisco
CallManager” procedure in theCisco Conference Connection Administration
Guide, use the guidelines inCTI Port Addition in Cisco CallManager,
page 20.

b. Use the“Setting up Cisco Conference Connection Users” section on page.

c. Perform the database subsystem configuration in the“Configuring the
Cisco Customer Response Application (Cisco CRA) Database Subsyste
section on page 28.

d. Perform the steps in the“Configuring the Cisco Customer Response
Application (Cisco CRA) Operator Extension” section on page 29.

e. Perform the steps in the“Configuring JTAPI for Cisco CallManager Failover
Support” section on page 30.

f. Perform the steps in the“Configuring Music on Hold for
Cisco Conference Connection” section on page 31.

Step 4 Perform the procedures in Chapter 4 “Cisco Conference Connection
Administration” in theCisco Conference Connection Administration Guide.

When configuring “Licensing Setup” and “Licensing Update,” use the guidelin
in the“Enabling Licenses for Cisco Conference Connection” section on page.
18
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Installing the Operating System

The instructions to install the operating system are provided in the
Cisco CallManager documentation. See the “Starting the Operating System
Installation” section of the following release note:

http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/3_1/install/
cm313ins.htm

To install the operating system for Cisco Conference Connection, use the C
CallManager “Starting the Operating System Installation” procedure along w
the following information specific to Cisco Conference Connection:

Procedure

Step 1 Use the installation instructions for the server type that you are installing.

Note Cisco Conference Connection does not support the IBM xSeries 330
servers.

Step 2 In Step 14, enter the product key FVHD-IAZA-ROFJ-DERJ.

Step 3 After you install the Operating System do not proceed to the section “Installi
Cisco CallManager.” Instead, continue with the Cisco Conference Connectio
installation and follow the instructions in the section “Installing Cisco Conferen
Connection” in theCisco Conference Connection Administration Guide.
19
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CTI Port Addition in Cisco CallManager

Follow these guidelines along with the “Adding CTI Ports in Cisco CallManage
procedure in theCisco Conference Connection Administration Guide.

To determine the number of CTI ports in Cisco CallManager that you need f
Cisco Conference Connection:

• For a 20-port license, configure 10 CTI ports.

• For a 60-port license, configure 10 CTI ports.

• For a 100-port license, configure 15 CTI ports.

Note The CTI port is only active as a participant accesses the IVR; therefore, a CTI p
is not required for each Cisco Conference Connection participant.

Setting up Cisco Conference Connection Users

This section contains the following procedures.

• Automatically Starting the User Synchronization Process, page 20

• Adding Additional Servers for Cisco Conference Connection for
Cisco CallManager 3.1, page 22

• Manually Starting the Synchronization Process for Cisco CallManager 3
page 23

• Adding Additional Servers for Cisco Conference Connection for
Cisco CallManager 3.2, page 25

• Changing the Synchronization Process TimeInterval Parameter for
Cisco CallManager 3.2, page 26

• Stopping the Synchronization Process for Cisco CallManager 3.2, page

Automatically Starting the User Synchronization Process

The installation CD-ROM comes with an installation to facilitate setting up
Cisco Conference Connection users. Use the following procedure instead of
“Starting the Synchronization Process” procedure under “Setting up Cisco
Conference Connection Users” in the configuration chapter of the
Cisco Conference Connection Administration Guide.
20
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To install the Automated User Synchronization Tool, perform the following ste

Procedure

Step 1 Take the CD-ROM to the Cisco CallManager server.

Step 2 In the UserSynchInstall directory on the CD-ROM, runsetup.exe.

Step 3 At the welcome prompt, clickNext.

Step 4 At the Software License Agreement screen, clickYes to accept the license terms

Step 5 At the User Synchronization Configuration screen, enter the
Cisco Conference Connection server name or IP address and clickNext.

Note If your network uses DNS services, you can enter the DNS name of 
Cisco Conference Connection server. You must update the DNS serv
with the appropriate Cisco Conference Connection server name and 
address information before using that information here.

If your network does not use DNS services, you must enter the full IP
address of the server.

Step 6 At the Database Password screen, enter the password specified during the
Cisco Conference Connection installation and clickNext.

Step 7 Confirm the installation and clickYes.

Step 8 Click Finish to complete the installation.

This completes the user synchronization between Cisco CallManager and o
Cisco Conference Connection server.

If you require additional servers, perform the steps in one of the following
procedures:

• Adding Additional Servers for Cisco Conference Connection for
Cisco CallManager 3.1, page 22

• Adding Additional Servers for Cisco Conference Connection for
Cisco CallManager 3.2, page 25.
21
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Adding Additional Servers for Cisco Conference Connection for Cisco CallManager 3.1

Warning Failure to follow the manual process for attachment of subsequent
Cisco Conference Connection servers will damage the previously installed
synchronization component.

To add additional Cisco Conference servers, use the following guidelines alo
with the “Starting the User Synchronization Process” section of the
Cisco Conference Connection Administration Guide.

• In Step 1, Configure an ODBC Data Source.

You must configure a new DSN for each synchronization process. Use
different DSN names for different synchronization agreements. For exam

DCMS1, DCMS2

• In Step 3: Copy odbcagr.txt.

Make sure that you do not overwrite the configuration files for a
synchronization agreement. Copy the files into a different directory.

• In Step 4: Edit the odbcagr.txt.

– Give the correct path name for the configuration file “odbcdcms.cfg,” th
location where the files have been copied.

– Enter the correct name for the “datasourse” (for example, DCMS1,
DCMS2).

– Make sure that you specify a unique agreement ID. It must not confl
with the agreement IDs used for any other synchronization agreeme

• In Step 5:

– When you run the command “dcmdlkag”, make sure that you give th
correct path name for the “ocbcagr.txt'” file.

• When you stop the Synchronization process, make sure that you give th
correct path name for the “delete.txt” file.
22
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Manually Starting the Synchronization Process for Cisco CallManager 3.2

Use this procedure only if you are adding additional servers for
Cisco Conference Connection running Cisco CallManager 3.2 (see the“Adding
Additional Servers for Cisco Conference Connection for Cisco CallManager 3
section on page 25).

To set up user synchronization with only one Cisco Conference Connection
server, follow the guidelines in the“Automatically Starting the User
Synchronization Process” section on page 20.

To set up Cisco Conference Connection users and start the manual
synchronization process, perform the following steps on the
Cisco CallManager 3.2 server.

Step 1 Configure an ODBC data source on the Cisco CallManager directory machine
follows:

a. From Windows 2000 desktop, selectStart > Programs >Administrative
Tools > Data Sources (ODBC).

b. Select theSystem DSN tab and clickAdd.

c. SelectSQL Server from the list of drivers, and clickFinish.

d. At the next screen, enter DCMS in the Name field, and optionally enter a
description.

e. In the Server field, select the name of the server on which you have instal
Cisco Conference Connection and clickNext.

f. At the next screen, selectSQL Server authentication.

g. Enter ‘sa’ in the Login ID field and the password that you set during the
installation.
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If you receive this error: “Connection failed.... client unable to establish
connection”, then you will need to do the following:

– Click OK .

– To change network library used to communicate with SQL Server, cli
Client Configuration .

– Select the appropriate network library; generally this would be Name
Pipes or TCP/IP.

– Click OK .

– Click Next.

i. At the next screen, select “Change the default database to”, and selectDCMS
from the list as the default database.

j. Uncheck “Use ANSI nulls, paddings and warnings” and clickNext.

k. At the next screen, select “Use regional settings when outputting...” and cl
Finish.

The ODBC data source is created.

l. At the next screen, clickTest Data Source.

A screen pop-up should display “Tests Completed Successfully.”

Click OK .

m. At the next screen, clickOK  again.

Step 2 Copy ConvEmail.dll from the ccc\LDAPSync directory on the
Cisco Conference Connection CD to the $DCDSRVR\lib directory on the
Cisco CallManager directory machine (where $DCDSRVR is typically
C:\dcdsrvr).

Step 3 Copy odbcagr.txt.mmu, odbcdcms.cfg, and delete.txt.mmu from the
ccc\LDAPSync directory on the Cisco Conference Connection CD to the
$DCDCONFIG directory on the Cisco CallManager directory machine (wher
$DCDCONFIG is typically C:\dcdsrvr\run\dcx500\config).
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Step 4 Edit the odbcagr.txt.mmu file and verify the values of the following paramete

• configfile: check that the drive letter and path are correct

• suspensepath: enter the path to the suspense files (these are the files th
contain information about any synchronization problems)

• password: enter the password for the default database user that you set d
the installation.

• agreementID: enter the ID of ODBC Live Sync agreement (pick a random
number that is less than 10,000,000, which does not conflict with any exist
agreement IDs)

• TimeInterval: enter an interval (frequency of updates in seconds) that satis
your requirements. A typical interval is 600 (seconds).

Step 5 Make sure that the Metalink server is running. At the command prompt, enter
following command:

dcdmmu PROCESS $DCDSRVR\run\dcx500\config\odbcagr.txt.mmu
(where $DCDSRVR is the directory path, normally C:\dcdsrvr)

Adding Additional Servers for Cisco Conference Connection for Cisco CallManager 3.2

Warning Failure to follow the manual process for attachment of subsequent
Cisco Conference Connection servers will damage the previously installed
synchronization component.

To add additional Cisco Conference servers, use the following guidelines alo
with the“Manually Starting the Synchronization Process for Cisco CallManag
3.2” section on page 23.

• In Step 1, Configure an ODBC Data Source.

You must configure a new DSN for each synchronization process. Use
different DSN names for different synchronization agreements. For exam

DCMS1, DCMS2

• In Step 3: Copy odbcagr.txt.mmu.

Make sure that you do not overwrite the configuration files for a
synchronization agreement. Copy the files into a different directory.
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• In Step 4: Edit the odbcagr txt.mmu.

– Give the correct path name for the configuration file “odbcdcms.cfg,” th
location where the files have been copied.

– Enter the correct name for the “datasource” (for example, DCMS1,
DCMS2).

– Make sure that you specify a unique agreement ID. It must not confl
with the agreement IDs used for any other synchronization agreeme

• In Step 5:

– When you run the command “dcdmmu”, make sure that you give the
correct path name for the “ocbcagr.txt.mmu” file.

• When you stop the Synchronization process, make sure that you give th
correct path name for the “delete.txt.mmu” file.

Changing the Synchronization Process TimeInterval Parameter for Cisco CallManager 3.2

To change the TimeInterval parameter for Cisco CallManager 3.2, follow the
steps.

Note You do not have to stop the synchronization process before you chan
the TimeInterval parameter.

Step 1 Locate the odbcagr.txt.mmu file.

Step 2 Open the file and change the TimeInterval parameter to set it to the new value
seconds).

Step 3 Save and close the file.

Note The new TimeInterval will take effect approximately 5 minutes from th
time you saved and closed the odbcagr.txt.mmu file.
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Stopping the Synchronization Process for Cisco CallManager 3.2

Normally, after the synchronization process is started, you will not need to s
it. However, you may want to stop the synchronization process if:

• you are having problems

• you do not want any more changes in your Cisco CallManager user prof
to be synchronized with the Cisco Conference Connection database

Warning Stopping the synchronization process might create inconsistencies and users
might have difficulties logging in to the Cisco Conference Connection Web
Interface.

To stop the synchronization process, perform these steps on the
Cisco CallManager 3.2 directory machine:

Step 1 Locate C:\$DCDSRVR\run\dcx500\config\delete.txt.mmu.

Step 2 In the delete.txt.mmu file, change the agreementID parameter so that it is the s
as the one in odbcagr.txt.mmu.

Step 3 At the command prompt, enter the following command:

dcdmmu PROCESS $DCDSRVR\run\dcx500\config\delete.txt.mmu
(where $DCDSRVR is the directory path, normally C:\dcdsrvr)

Step 4 At the command prompt, enter the following command:

dcdexprt ALL export.gen /o=cisco.com/ou=Users

Step 5 At the command prompt, enter the following command to delete all the entri
under this subtree:

dcddel /o=cisco.com/ou=Users

Step 6 At the command prompt, enter the following command to re-import the export
data:

dcdimprt POPULATE export.gen

This will stop the synchronization between the Cisco CallManager directory
machine and the Cisco Conference Connection server.
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Configuring the Cisco Customer Response Application (Cisco CRA) Database
Subsystem

You must configure the Cisco CRA database if you are installing
Cisco Conference Connection 1.1(3) for the first time or if you are upgrading
from Cisco Conference Connection 1.1(1).

If you are upgrading from Cisco Conference Connection 1.1(1), start with the
“Upgrading Cisco Conference Connection” section on page 33.

If this is a new installation of Cisco Conference Connection, perform the
following procedure:

Procedure

Step 1 Connect to the Application Administration web server by using the following
URL:

http://servername/Appadmin

whereservernameis the DNS name or IP address of your
Cisco Conference Connection server.

If you are using the computer that is running the Cisco Conference Connect
server, you can connect to the web pages by choosing:

Start > Programs > Cisco CRA Administrator > Application Administrator .

Step 2 Click Database.

Step 3 Click Add New Data Source.

Step 4 Enter the following information:

• Data Source Name:DCMS

• Username:sa

• Password: enter the password specified for MSDE during the installation
Cisco Conference Connection

• Maximum Number of Connections: enter the same number as the numbe
configured CTI ports
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To determine the number of CTI ports in Cisco CallManager that you need f
Cisco Conference Connection, follow these guidelines:

• For a 20-port license, configure 10 CTI ports.

• For a 60-port license, configure 10 CTI ports.

• For a 100-port license, configure 15 CTI ports.

Note The CTI port is only active as a participant accesses the IVR; therefore, a CTI p
is not required for each Cisco Conference Connection participant.

Step 5 Click Update.

Configuring the Cisco Customer Response Application (Cisco CRA) Operator
Extension

When configuring the conference telephony application, you can either enabl
disable the transfer to the operator extension feature.

To enable operator extensionOn the last configuration screen of the conferenc
telephony application, enter a valid operator extension in the operatorExtn fi

To disable operator extensionOn the last configuration screen of the conferenc
telephony application, you must enter the word stringnull in the operatorExtn
field.

Note When you disable operator extension, if you enter any other string or an inva
extension instead of enteringnull , an error message (“This extension is invalid.”
plays.
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Configuring JTAPI for Cisco CallManager Failover Support

For Cisco CallManager failover support on Cisco Conference Connection, yo
must configure JTAPI in the Cisco Customer Response Application (Cisco CR

Note The primary Cisco CallManager must be fully operational and running when t
JTAPI engine starts up.

Perform the following steps to configure JTAPI for failover support:

Procedure

Step 1 Connect to the Application Administration web server by using the following
URL:

http://servername/Appadmin

whereservernameis the DNS name or IP address of your
Cisco Conference Connection server.

If you are using the computer that is running the Cisco Conference Connect
server, you can connect to the web pages by choosing:

Start > Programs > Cisco CRA Administrator > Application Administrator .

At the prompts, enter the network username and password.

Step 2 Click JTAPI .

Step 3 In the JTAPI providers field, enter the DNS name or IP address of the prima
Cisco CallManager and then enter the secondary Cisco CallManager. Make
a space separates the two DNS names or IP addresses.

For example, enterCM3 CM4  where CM3 is the primary Cisco CallManager
server name.

Step 4 Provide the JTAPI user and password and clickUpdate.
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Configuring Music on Hold for Cisco Conference Connection

Use this procedure to disable the Music On Hold feature for
Cisco Conference Connection and to allow the feature for calls between IP
phones. This procedure prevents music on hold from being played into a
conference for callers within the same Cisco CallManager cluster. This does
prevent music being played from other sources, such as remote callers on o
systems.

This configuration is recommended so that the music on hold feature does n
disrupt conferences when a participant places the conference on hold.

This configuration adds all of the music on hold resources into a Media Resou
Group (other than the default). This ensures that music on hold is then avail
only to entities in the resource group list, where that Media Resource Group
included.

This procedure uses a new Media Resource Group and List for example onl
Creation of new groups/lists is not required but may be used. The underlying
principle is to have music on hold resources outside of the default group (ea
device is assigned a default, when it is added). See the Cisco CallManager
documentation to configure a phone or other devices into a Media Resource
Group List.

Note The Cisco Conference Connection H.323 gateway device must NOT be with
group or list that contains music on hold resources. Failure to do this may re
in music on hold being played in conference and confusing messages being
played.

Perform the following steps to disable the Music on Hold feature with
Cisco Conference Connection:

Procedure

Step 1 On the Cisco CallManager administration page, go to
Services > Media Resource Group.

Step 2 Click Add a new media resource groupand provide a name for the new group
on the next page, for example, MOHGroup.
31
Release Notes for Cisco Conference Connection 1.1(3)

OL-2425-01



Documentation Addenda

 the

ew

w
nd

ts.
g on

s:
Step 3 In the selection box, select all the Music On Hold resources and put them in
new group, such as, MOHGroup.

Step 4 Go toServices > Media Resource Group List.

Step 5 Add a new Resource Group List (for example, MOHList) and then add the n
group created in step 2 to this list.

All IP phones that require the Music On Hold feature must be part of this list. No
all entities that belong to this group list will be able to receive music on hold a
users of Cisco Conference Connection will not hear music.

Enabling Licenses for Cisco Conference Connection

Use this information along with the “Licensing Setup” and the “Licensing
Update” sections in theCisco Conference Connection Administration Guide.

Initial Cisco Conference Connection installation provides six conference por
To enable additional ports, you must perform one or several steps dependin
the number of license upgrades.

License keys are required as described here:

• 6 to 20 port upgrade

• 20 to 60 port upgrade

• 60 to 100 port upgrade

• 20 to 100 port upgrade

For example, if 100 ports are purchased, you will perform the following step

1. Use the first license key and upgrade 6 to 20 ports.

2. Use the second license key and upgrade 20 to 100 ports.

After entering all license keys, restart Cisco Conference Connection for the
changes to take effect.
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Upgrading Cisco Conference Connection
To upgrade Cisco Conference Connection, perform the following procedures

• Preparing to Upgrade, page 34

• Upgrading Cisco Conference Connection, page 35

• Restoring the Configuration for Cisco Conference Connection, page 36

• Configuring Music on Hold for Cisco Conference Connection, page 31

• Enabling Licenses for Cisco Conference Connection, page 32
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Preparing to Upgrade

Before you begin the upgrade, have the following information available:

• The MSDE password for the user named “sa.”

• License keys for all purchased licenses.

• The directory hostname/IP address and the profile name.

To obtain the Directory hostname/IP address and the profile name, perform 
following steps:

Procedure

Step 1 Connect to the Application Administration web server by using the following
URL:

http://servername/Appadmin

whereservernameis the DNS name or IP address of your
Cisco Conference Connection server.

If you are using the computer that is running the Cisco Conference Connect
server, you can connect to the web pages by choosing:

Start > Programs > Cisco CRA Administrator > Application Administrator .

At the prompts, enter the network username and password.

Step 2 On the menu page, go to Directory and note the Directory hostname as well as
profile selected in the box on the right of the web page.

For more information, refer to the “Configuring Directory Information” section i
theCisco Conference Connection Administration Guide.
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Upgrading Cisco Conference Connection

Before starting the upgrade, make sure that no conferences are currently run

Perform the following steps to upgrade Cisco Conference Connection to the
current release:

Procedure

Step 1 Go toStart > Programs > Cisco Conference Connection.

Step 2 In the menu, chooseUninstall.

Step 3 In the dialog box “Are you sure you want to uninstall?” chooseYes.

Step 4 At the end of the uninstall, you may get a dialog (“It is recommended that yo
restart the machine to remove files....”).
Click OK.

Step 5 After the uninstall, reboot or restart the server.

Step 6 After the reboot, insert the Cisco Conference Connection Release 1.1(3)
CD-ROM into the server, or, if you have the zip file, unzip the contents of the z
file into a temporary directory of your choice. Do NOT unzip contents onto th
desktop.

Step 7 Complete the steps outlined in the “Installing from the CD-ROM” section in th
Cisco Conference Connection Administration Guide(Steps 1 through Step 17).

Note For the JTAPI client, you will receive a dialog asking you to choose a
action for JTAPI client installation. ChooseUpgrade JTAPI client. Then
continue as outlined in the Administration Guide.

Step 8 During the installation, enter the MSDE password when prompted.

After you complete the installation, restart the server.
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Restoring the Configuration for Cisco Conference Connection

Perform the following procedures to restore the configuration for
Cisco Conference Connection:

Procedure

Step 1 Connect to the Application Administration web server by using the following
URL:

http://servername/Appadmin

whereservernameis the DNS name or IP address of your
Cisco Conference Connection server.

If you are using the computer that is running the Cisco Conference Connect
server, you can connect to the web pages by choosing:

Start > Programs > Cisco CRA Administrator > Application Administrator .

At the prompts, enter the network username and password.

The Directory information appears.

Step 2 Verify that the Directory Hostname and the profile name are the same as in
“Preparing to Upgrade” section on page 34.

Step 3 On the Main Menu page, verify that the Database option appears.

Step 4 Perform the database configuration in the“Configuring the
Cisco Customer Response Application (Cisco CRA) Database Subsystem”
section on page 28.

Note In this release of Cisco Conference Connection, the Operator Extension featu
optional. You may disable it. See“Configuring the Cisco Customer Response
Application (Cisco CRA) Operator Extension” section on page 29.
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Step 5 After configuring the database, go back to the menu and choose the Engine op

Note At this time you may need to configure JTAPI for failover. See the“Configuring
JTAPI for Cisco CallManager Failover Support” section on page 30.

Step 6 Check that the following subsystems appear and that they are in service:

• Database

• Application

• JTAPI

This may take some time to reflect. Use the refresh checkbox to check the sta
If the status does not change, restart the engine and check the status.

The configuration restore is complete. You may now start and join conferenc

To Disable Music On Hold

To disable the Music On Hold feature for Cisco Conference Connection whil
allowing the feature for calls between IP phones, perform the steps in the
“Configuring Music on Hold for Cisco Conference Connection” section on
page 31.

To Enable Licenses

If you have purchased additional licenses, perform the steps in the“Enabling
Licenses for Cisco Conference Connection” section on page 32.
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Upgrading from Cisco CallManager 3.1
If you have upgraded Cisco CallManager 3.1 to a later release of
Cisco CallManager, perform the following steps to enable
Cisco Conference Connection to work properly:

Procedure

Step 1 Log into the Cisco CallManager administration page

http://servername/ccmadmin

where the server name is the IP address of the Cisco CallManager server.

Step 2 ChooseRoute Plan > Route Pattern and select the route pattern that is
configured for the Cisco Conference Connection server.

Step 3 In the Route Pattern Configuration page, go to Route Pattern entry box and a#
at the end of the route pattern string.

For example, change 5321.! to 5321.!#

Step 4 Click Update.
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Changes to Cisco Conference Connection When Upgrading from
Cisco CallManager 3.1 to Cisco CallManager 3.2

When you upgrade Cisco CallManager 3.1 to Cisco CallManager 3.2, you m
perform the following procedures to enable Cisco Conference Connection to
work properly:

• Upgrading the JTAPI Client, page 39

• Repairing the User Synchronization Process on Cisco CallManager, pag

Upgrading the JTAPI Client

Procedure

Step 1 Log into the Application Engine web page

http://servername/AppAdmin

where the server name is the DNS name or IP address of the
Cisco Conference Connection server.

or

If you are working on the Cisco Conference Connection server, go to
Start>Programs>Cisco Extended Services Administrator>
Application Administrator

Step 2 Click on Engine.
The Engine Status page displays.

Step 3 Click on theStop Engine button.

Step 4 Open the browser on the Cisco Conference Connection server and log into t
Cisco CallManager administration page

http://servername/ccmadmin

where the server name is the DNS name or IP address of the
Cisco Conference Connection server.

Step 5 Click on Application>Install Plugins>Cisco JTAPI.

Step 6 Choose “Run program from its current locations,” and click OK .

Step 7 At the prompt “Do you want to install and run Cisco JTAPIClient.exe?”, clickYes.
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Step 8 At the prompt “Cisco JTAPI Client ver. X.X(x.x)”, clickContinue.

Step 9 On the Maintenance Operations screen, choose “Upgrade from vX.X(x) to
vX.X(x)” and click Next.

Step 10 Choose “Yes, I want to restart my computer” and clickFinish.

Repairing the User Synchronization Process on Cisco CallManager

The upgrade from Cisco CallManager 3.1 to Cisco CallManager 3.2 corrupts
the User Synchronization process. You must repair the User Synchronizatio
process on the Cisco CallManager server after upgrading Cisco CallManage

Note Before you upgrade Cisco CallManager, make sure you rename ConvEmail.d
c:\dcdsrvr\lib on the Cisco CallManager server. See the Cisco CallManager
release notes
(http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/3_2/install/
grade/upgra321.htm#xtocid6) for more information.

Use this procedure to repair the User Synchronization process after upgradi
Cisco CallManager.

Procedure

Step 1 Download Cisco Conference Connection Version 1.1(3) Support Patch A fro
this URL. The patch is ccc-1-1-3-spA.exe.

http://www.cisco.com/cgi-bin/tablebuild.pl/ccc

Step 2 Follow the instructions in ccc-1-1-3-spA.README.txt (available at the same
URL).

Step 3 After you run the batch file, if the results say “No Metalink Agreements current
running...,” then you need to set up a new User Synchronization process for C
Conference Connection. Use the procedure in the“Automatically Starting the
User Synchronization Process” section on page 20.
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Installing Japanese Voice Prompts
Perform the following steps to install Japanese voice prompts.

Note This procedure installs Japanese voice prompts but does not add Japanese
characters to the web interface.

Procedure

Step 1 Complete the IVR/CCC installation as described in the
Cisco Conference Connection Administration Guide.

Step 2 Restart your server after installation.

Step 3 Run the following batch file:

C:\Program Files\Cisco\ConferenceConnection\InternationalPrompts\
setupJapanesePrompts.bat

Step 4 At the prompt “Do you want to overwrite existing .wav files,” replyALL .

Note Default backup subdirectories are created to save the original prompt
three directories:
C:\Program Files\wfavvid\Prompts\system\en_US
C:\Program Files\wfavvid\Prompts\user\en_US
C:\Program Files\Cisco\ ConferenceConnection\Prompts
Users can restore English prompts from defaultbackup directories.

Step 5 Restart the application engine.
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Obtaining Documentation
The following sections explain how to obtain documentation from Cisco Syste

World Wide Web
You can access the most current Cisco documentation on the World Wide We
the following URL:

http://www.cisco.com

Translated documentation is available at the following URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM
Cisco documentation and additional literature are available in a Cisco
Documentation CD-ROM package, which is shipped with your product. The
Documentation CD-ROM is updated monthly and may be more current than
printed documentation. The CD-ROM package is available as a single unit o
through an annual subscription.

Ordering Documentation
Cisco documentation is available in the following ways:

• Registered Cisco Direct Customers can order Cisco product documenta
from the Networking Products MarketPlace:

http://www.cisco.com/cgi-bin/order/order_root.pl

• Registered Cisco.com users can order the Documentation CD-ROM thro
the online Subscription Store:

http://www.cisco.com/go/subscription

• Nonregistered Cisco.com users can order documentation through a loca
account representative by calling Cisco corporate headquarters (Californ
USA) at 408 526-7208 or, elsewhere in North America, by calling 800
553-NETS (6387).
42
Release Notes for Cisco Conference Connection 1.1(3)

OL-2425-01

http://www.cisco.com
http://www.cisco.com/public/countries_languages.shtml
http://www.cisco.com/cgi-bin/order/order_root.pl
http://www.cisco.com/go/subscription


Obtaining Technical Assistance

it

nd

over

d
ce

o the

t
,

use
Documentation Feedback
If you are reading Cisco product documentation on Cisco.com, you can subm
technical comments electronically. ClickLeave Feedback at the bottom of the
Cisco Documentation home page. After you complete the form, print it out a
fax it to Cisco at 408 527-0730.

You can e-mail your comments to bug-doc@cisco.com.

To submit your comments by mail, use the response card behind the front c
of your document, or write to the following address:

Cisco Systems
Attn: Document Resource Connection
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
Cisco provides Cisco.com as a starting point for all technical assistance.
Customers and partners can obtain documentation, troubleshooting tips, an
sample configurations from online tools by using the Cisco Technical Assistan
Center (TAC) Web Site. Cisco.com registered users have complete access t
technical support resources on the Cisco TAC Web Site.

Cisco.com
Cisco.com is the foundation of a suite of interactive, networked services tha
provides immediate, open access to Cisco information, networking solutions
services, programs, and resources at any time, from anywhere in the world.

Cisco.com is a highly integrated Internet application and a powerful, easy-to-
tool that provides a broad range of features and services to help you to

• Streamline business processes and improve productivity

• Resolve technical issues with online support

• Download and test software packages
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• Order Cisco learning materials and merchandise

• Register for online skill assessment, training, and certification programs

You can self-register on Cisco.com to obtain customized information and serv
To access Cisco.com, go to the following URL:

http://www.cisco.com

Technical Assistance Center
The Cisco TAC is available to all customers who need technical assistance wi
Cisco product, technology, or solution. Two types of support are available throu
the Cisco TAC: the Cisco TAC Web Site and the Cisco TAC Escalation Cente

Inquiries to Cisco TAC are categorized according to the urgency of the issue

• Priority level 4 (P4)—You need information or assistance concerning Cis
product capabilities, product installation, or basic product configuration.

• Priority level 3 (P3)—Your network performance is degraded. Network
functionality is noticeably impaired, but most business operations contin

• Priority level 2 (P2)—Your production network is severely degraded,
affecting significant aspects of business operations. No workaround is
available.

• Priority level 1 (P1)—Your production network is down, and a critical impac
to business operations will occur if service is not restored quickly. No
workaround is available.

Which Cisco TAC resource you choose is based on the priority of the problem
the conditions of service contracts, when applicable.
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Cisco TAC Web Site

The Cisco TAC Web Site allows you to resolve P3 and P4 issues yourself, saving
both cost and time. The site provides around-the-clock access to online tool
knowledge bases, and software. To access the Cisco TAC Web Site, go to th
following URL:

http://www.cisco.com/tac

All customers, partners, and resellers who have a valid Cisco services contr
have complete access to the technical support resources on the Cisco TAC 
Site. The Cisco TAC Web Site requires a Cisco.com login ID and password. If y
have a valid service contract but do not have a login ID or password, go to t
following URL to register:

http://www.cisco.com/register/

If you cannot resolve your technical issues by using the Cisco TAC Web Site, a
you are a Cisco.com registered user, you can open a case online by using the
Case Open tool at the following URL:

http://www.cisco.com/tac/caseopen

If you have Internet access, it is recommended that you open P3 and P4 cas
through the Cisco TAC Web Site.

Cisco TAC Escalation Center

The Cisco TAC Escalation Center addresses issues that are classified as pr
level 1 or priority level 2; these classifications are assigned when severe netw
degradation significantly impacts business operations. When you contact the T
Escalation Center with a P1 or P2 problem, a Cisco TAC engineer will
automatically open a case.

To obtain a directory of toll-free Cisco TAC telephone numbers for your count
go to the following URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

Before calling, please check with your network operations center to determine
level of Cisco support services to which your company is entitled; for examp
SMARTnet, SMARTnet Onsite, or Network Supported Accounts (NSA). In
addition, please have available your service agreement number and your pro
serial number.
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